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MILITARY TECHNOLOGICAL COLLEGE 

Delivery Plan - Year 2024-25 [Term 1] 

Title / Module Code / 

Programme   

Computing 

/MTCG1015/FPD Module Coordinator Ms. Rehana Anjum 

Lecturers TBA Resources & Reference books  Moodle & Workbook 

Duration & Contact 

Hours 
Term 1: 5 hrs x 11 weeks = 55 hours  

 

  

WEEK No Chapter TOPICS Hours L O No 

1 1 

What is a Computer, Data, Information 

5 1 

Basic Applications, Basic functional Blocks of Computer, Work of each 

Block  

Computer Components, Essential Computer Hardware,  

Input Unit, Storage Devices, Unit of data measurements, Primary 

storage devices  

Secondary storage devices, CPU   

2 1 

Output Unit, Motherboard, PSU, Ports  

5 1 

Different types of computers  

Software, System software, Application software, Programming 

languages and software  

Software copyright, Omani data protection legislation, Install and 

uninstall software applications  

Minimum laptop computer configurations for students, Computer 

Ergonomics  

3 

2 

Switching On the computer, Getting started with Windows 10, Working 

with files, 

3 2 

Adjusting Computer settings, shutting down the computer, other ways 

to exit the computer properly, Ribbons, menus, and toolbars, File 

management. [CA1 until this topic] 

File Explorer, Working with files and Folders, Components of File 

explorer 

Malware  

1&2 Revision for CA1 1 1 & 2 

1&2 CA1 (20%) [Chapter 1] and [Chapter 2 until file management] 1 1 & 2 
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4 

2 

Password, Backing up of data  

5 

2 Compress and Decompress Files and Folders, Formatting Storage Media, 

Built in help  

3 

Computer Networks, IP Address, Data transfer rate, LAN, WAN, MAN  

3 
Advantages/Disadvantages of Using a Network, Intranet, Extranet, 

Internet, Brief history of Internet, Internet devices, Dial-Up, Broadband  

WWW (World Wide Web), Web Browsers, Web servers   

5 3 

URL, Domain, Using web, Search Engine 

5 3 

Electronic mail, E-mail address structure, Parts of an E-mail message 

Microsoft Outlook functionalities, How E-mail works 

Moodle and Outlook, Conferencing, 

VoIP, Instant messaging, Blogs, Things to be cautious about on the 

Internet, Risks to personal and organizational data 

6 

3 

How to protect data, Techniques to improve data security, Effects of IT 

on our lives and on Society [CA2 until this topic] 1 3 

4 Moodle file upload/download exercise 

Microsoft Setting Exercise, MS Word Exercise 4.1 1 

2&3 Revision for CA2 1 2&3 

2&3 CA2 (30%) [Chapter 2 and Chapter 3] 2 2&3 

7 4 

MS Word Exercise 4.1 (Cont.) 

5 4 
MS Word Exercise 4.2  

MS Word Exercise 4.3 

MS Word Exercise 4.4 

8 4 

MS Word Exercise 4.5 

5 
4 

MS Word Exercise 4.6 

MS Word Exercise 4.7 6 

9 5 

MS Word Exercise 4.8 

5 6 

MS Excel Exercise 4.9 

MS Excel Exercise 5.1 

MS Excel Exercise 5.2 

MS Excel Exercise 5.3 5 6 
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Indicative Reading 

Title/Edition/Author ISBN 

BASIC COMPUTER COURSE MADE SIMPLE (3rd  Ed, 2016),   

Author: Satish Jain   

Publisher: Bpb Publications 

ISBN – 13: 9788183334594  

ISBN – 10: 8183334598 

Computing Essentials 2021  

Author: Timothy J. O’Leary, Daniel O’Leary, Linda I. O’Leary  

Publisher: Mc Graw-Hill 

ISBN – 978-1-259-92127-8 

MICROSOFT OFFICE INSIDE OUT: 2021 (Microsoft 365) EDITION Author: 

Microsoft Corporation, Ed Bott and Carl Siechert  

Publisher: Sebastopol, CA: O'Reilly Media, Inc., 2013 

ISBN – 9780735677562 

WINDOWS 11 FOR DUMMIES  

Author: Andy Rathbone  

Publisher: Hoboken, NJ: Wiley, 2021 

ISBN – 9781118134610 

 

 

Fundamentals of Computer Science (1st Edition August 2023),   

Author: Dr. Mahalingam Palaniandi and Dr. R. Selvam 

Publisher: VR1 Publications 

ISBN : 978-93-91332-78-5 

 

   
   

Ms. Rehana Anjum Dr. T. Raja Rani MQM/Salim Al Shibli 
Module Coordinator Deputy Head of FPD (C/M/P) Head of FPD 

 

  

10 5 & 6 

MS Excel Exercise 5.4 

MS Excel Exercise 5.6 

MS Excel Exercise 5.10 

MS PowerPoint Exercise 6.1 5 

11 
6 

MS PowerPoint Exercise 6.2 

5 5 
MS PowerPoint Exercise 6.3 

MS PowerPoint Exercise 6.4 

MS PowerPoint Exercise 6.7 

4, 5 & 6 FINAL EXAM (50%) [Chapter 4, Chapter 5, and Chapter 6] 90 min  4, 5 & 6 

  TOTAL Teaching hours 55hrs  
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Microsoft Office Settings 

Microsoft Exercise: Formatting Language Setting 

1. Create a word document 

2. Open the document 

3. Navigate to the File menu 

4. Click on Options 

5. Click on Language option 

6. Click Add a Language Button  

7. Choose ‘English (United States) 

8. Click on the button Set as default 

9. Save and close the document 

 

Microsoft Exercise: Formatting Measurement Setting  

1. Create a word document 

2. Open the document. 

3. Navigate to the File menu 

4. Click on Options 

5. Click on Advance option 

6. Go to Display section 

7. Format: Show measurements in unit of: inches 

8. Click ok button at the end 

9. Save and close the document 
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MS Word Exercises 

MS Word Exercise 4.1 

1. Create a folder on the Desktop. 

2. Name the folder as MS Word Exercises.  

3. Create a New Word document and Rename as <your student number-4.1>. 

4. Open the word document.  

5. Page Size: A4 

6. Page Orientation: Portrait 

7. Page Margins: Moderate 

8. Type the following text as it is in page1 of the document: 

[Today’s Date] 

341 Company Address 

Company City, State  

hiring.manager@gmail.com 

Dear Mr. Salim, 

I’m writing to you regarding the marketing role that opened up recently. I came across the job 

description on www.jobvacancies.com and was delighted to find that my academic 

accomplishments meet all of the necessary requirements. I am seeking a challenging but rewarding 

internship. 

As a junior marketing student at the University of Georgia, I have acquired skills in advertising, 

PR and market research. Currently I hold a 3.8 GPA. While in the College of Business, I have 

strategically focused my coursework in the following areas: 

a. Marketing Analytics 

b. Marketing Management 

c. Survey Research 

d. Strategic Internet Marketing 

e. Integrated Marketing Communications 

Using my knowledge of the above, I designed a marketing campaign for a local pet grooming 

business that yielded the highest return on investment based on our given budget.  

I would be delighted to have an opportunity to personally interview with you. Please accept the 

enclosed resume and feel free to contact me at your earliest convenience.  

Yours sincerely, 

[Your Name] 

9. Insert Today’s Date in the letter (Use current Date and Time). 

  



Page | 3  
FPD-COMPUTING [MTCG1015] 
 

10. Format the Address (1st three lines) of the letter: 

a. Font: Lucida Bright    

b. Font Size: 14 points  

c. Font Style: Bold 

d. Font Color: Blue  

11. Format the email id (hiring.manager@gmail.com), apply Text effect Glow. 

12. Select all the text from Dear Mr. Salim until end of the page and format: 

a. Font: Cambria 

b. Font Size: 14 points  

c. Alignment: Justify 

13. Select the text in 1st and 2nd Paragraph and format: 

a. Change case: Capitalize Each Word  

14. Apply Font style Italics to the text www.jobvacancies.com in 1st Paragraph. 

15. In the 1st paragraph, Bold the word "challenging" and Highlight it with turquoise color. 

16. Select the listed text and format: 

a. Apply Bullets of your choice to the text. 

b. Apply Left Indent (before text) at 1”  

17. Select the second last paragraph and format: 

a. Apply First line indent at 1.2” 

18. Select the last paragraph and format: 

a. Apply Hanging indent at 1” 

19. Apply outside borders to the last paragraph.  

20. Shade the last paragraph with grey color. 

21. Select the second last Line (Yours sincerely) and format: 

a. Font: Bradley Hand ITC    

22. Select your name typed in the last Line and format: 

a. Font: Blackadder ITC    

b. Font Size: 16 points 

  

mailto:hiring.manager@gmail.com
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23. Select text starting from ‘Dear Mr. Salim’ until last paragraph, 

Apply paragraph Spacing Before: 12pt and After: 12pt. 

24. Select bulleted text, apply Line Spacing 1.5 lines. 

25. Insert Symbol of Smiley face at the end of your name. 

26. Do the automatic spelling/grammar check & correct the spelling mistakes in the letter. 

27. Save the document. 

Note to Lecturers: Inform students about other available options for line spacing (single, double, and multiple), 

alignment (center, right, and left), indents, margins (custom, gutter, etc.), and page size (Height & Width).  
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MS Word Exercise 4.2 
 

1. Create a New Word document and Rename as <your student number-4.2>.  

2. Open the word document.  

3. Customize the Page size to Height:12” & Width:9”, and Page orientation Landscape 

4. Insert a logo of Military Technological College (Use Google or online picture) on page 1. 

5. Apply picture effect to the picture.  

6. Apply an artistic effect to the picture.  

7. Insert a Page break on page1. 

8. Insert a picture of MTC (Use Google or online picture) on page 2.  

9. Apply any picture style to the picture. 

10. Insert the following shape on page 2, move the shape above the picture such that you can view both 

shape and picture. 

 

 

11. Fill the shape with any color. 

12. Apply Shape Effects with Shadow. 

13. Insert a text box on page 3 and type the text ‘MTC General Studies’.  

14. Apply any shape style to the text box.  

15. Insert the following SmartArt in page 3: 

                   

 

Name of the SmartArt is ____________________________________________ 

 

16. Apply a SmartArt style to the SmartArt.  
 

Computing
Basic 

Mathematics
Pure 

Mathematics 
Physics

MTC 
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17. Insert WordArt on page 4 and type ‘Students Overall Result’.  

 

18. Insert a 3-D Clustered Column Chart on page 4 for the following data:  
 
 

 Mid Term Final Exam 

Computing 58 74 

Basic Math  86 91 

Pure Math  77 62 

Physics 52 60 

 

Resize the chart and place it below WordArt. 

 

19. Insert a page number at the bottom of the page.  

20. Save the document  
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MS Word Exercise 4.3 

1. Open your MS Word Exercises folder.  

2. Create a New Word document and Rename as <your student number-4.3>.  

3. Insert the following table:  
P

er
io

d
ic

 T
a
b

le
 Atomic Structure 

Element Mass Number Protons Neutrons 

Sodium 23 11 12 

Boron 10 5 5 

Aluminum 27 13 14 

Chlorine 35 17 18 

Fluorine 19 9 10 

 

4. Format the title (Atomic Structure) of the table with following:   

(a) Font: Cambria  

(b) Font size: 14 

(c) Text Effect: Shadow  

5. Format column1 (Periodic Table) of the table with 

(a) Font: Britannic Bold 

(b) Font size: 15 

(c) Font style: Underline  

6. Format the Column headings (Element, Mass Number, Protons, and Neutrons) of the table with, 

font color: Green.  

7. Apply shading of any color to the table.  

8. Apply a border style (choose any line style) for all cells in the table with, Pen color: Blue.  

9. Split the table into two tables after the record ‘Boron’.  

10. Delete the first column from the 2nd table.  

11. Format the second table according to the following:  

(a) Insert a new row above the record ‘Chlorine’: 

(b) Insert a new row below the record ‘Fluorine’:  

Carbon 12 6 6 

Magnesium 24 12 12 
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(c) Insert the column given below to the left of the column1: 

 

 

12. Copy the second table and paste on page 2.  

13. Do the following table formatting on page 2:  

(a) Sort the 2nd column of the table in descending order.  

(b) Copy the table and paste on page 3.  

14. Do the following table formatting on page 3:  

(a) Sort the 3rd column of the table in ascending order.  

(b) Insert a new row above the record ‘Carbon’ as:  

Symbol Element M P N 

(c) Apply a table style of your choice to the table.  

(d) Insert a new row below the record ‘chlorine’  

(e) Insert a new column after the column N.  

(f) Set the height of the last row to 0.5”  

(g) Set the width of the 3rd, 4th and 5th column to 0.6”  

15. Calculate Total of all the cells in column M and display the sum at the bottom of this column.  

16. Calculate Average of all the cells in column P and display the answer at the bottom of this column.  

17. Find out the maximum number in the table and display the answer in the 2nd row last column.  

18. Find out the minimum number in the table and display the answer in the 3rd row last column.  

19. Find out how many numbers are in the table and display the answer in the last row first column.  

20. Insert the following equation on Page 4 using Equation Editor 

 

21. Save the document. 

Note to Lecturers: Inform students about other available options in Equation editor  

Al 

C 

Cl 

F 

Mg 

𝑁𝑎11
23  

𝐶𝑙17
35  

𝑁𝑎 + 𝐶𝑙 → 𝑁𝑎𝐶𝑙  
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MS Word Exercise 4.4 

1. Create a New Word document and Rename as <your student number-exe4.4> 

2. Change the Page Margins, Top: 1”, Bottom: 1”, Left: 0.5”, Right: 0.5”. 

3. Type the following on page1: 

SUMMARY 

Tech-savvy, solution-oriented professional with experience in all aspects of office management, 

administration, and support. 
 

SKILLS 

Windows & Mac  

Microsoft Office  

Apple iWork 

SharePoint 

Salesforce 

QuickBooks 

Lotus Notes 

Adobe InDesign 

Adobe Photoshop 
 

TRAINING & EDUCATION 

Microsoft Office Specialist MICROSOFT OFFICE 2010 

Microsoft Certification 2008 
 

Bachelor of Arts BUSINESS ADMINISTRATION 

University of Illinois Springfield 1997 – 2001 
 

Associate Degree OFFICE ADMINISTRATION 

Lincoln Land Community College 1995 – 1997 
 

4. Insert drop cap for the word Tech-savvy (in paragraph 1). 

5. Insert header and type your Name, Student Number and Class.  

6. Apply a page border of your choice with a style in the document.  

7. Apply a page color of your choice to the document.  

8. Apply First line indent 0.3” to the text below “SKILLS”.  

9. Add the left tab stop at 5” to the text below “TRAINING & EDUCATION”, then align each year 

to the tab stop.  

10. Insert a footnote ‘ability to do something well’ for the word SKILLS. 

11. Insert an endnote ‘graphics editor’ for the word ‘Adobe Photoshop’. 

12. Insert Bookmark to the Subheading ‘TRAINING & EDUCATION’. 

13. Design a Custom Watermark in the document with the text ‘Resume’. 

14. Save the document. 
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MS Word Exercise 4.5 

 

1. Create a New Word document and Rename as <your student number-exe4.5> 

2. Set the page margins to 1.5” on all sides (Top, Bottom, Left, and Right). 

3. Insert a header ‘Science-fiction movies’.  

4. Set spacing after to 0 pt and line spacing to single. 

5. Type the text shown below on page1:  

Top 5 science-fiction movies: 

2001: A Space Odyssey (1968) 

Blade Runner (1982) 

Gattaca (1997) 

Aliens (1986) 

The Terminator (1984) 

 

6. Select the title Top 5 science-fiction movies and format font: Arial, font size: 16, and font style: 

bold. 

7. Select the remaining text (starting from 2001 to (1984)) and format font: Arial, font size: 12.  

8. Turn on the Show/Hide codes to view paragraph marks and other hidden formatting symbols in 

the document. 

9. Select all the text, copy and paste text on page2. 

10. Select the pasted text and Insert Table. 

11. Select text on page1, beginning with ‘2001:’ and ending with ‘(1984)’ do the following 

formatting, 

(a) Insert numbering. 

(b) Apply center aligned Tab at 4.0”. 

(c) Align each year at the end of the movie names to the tab stop.  

12. Insert a page border ‘3-D’. 

13. Save the document. 
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MS Word Exercise 4.6 
 

Step1 Create a Word document in MS Word Exercise folder. 

Step2 Rename the file as your “student ID Number”.  

Step3 Format the Page Size to A5.  

Step4 Format the Page Orientation to Landscape.  

Step5 Create the Table below on Page1.  

Estimate of tropical forest loss (hectares) - 2014 

Country  Rank Average Loss  

Brazil 1 2,262,241 

Indonesia 2 1,490,457 

Congo 3 1,100,880 

Malaysia 4 493,385 

 

Step6 Align Center the heading (title) of the Table.   

Step7 Change case into Capitalize Each Word in Table heading (title).   

Step8 Format the Table Font to Lucida Bright.  

Step9 Format the Table Font Size to 16 point.  

Step10 Insert your Name as Footer.  

Step11 Design Page Borders with setting Shadow.  

Step12  Design the document with Watermark “SAMPLE”(Choose from the available options). 

Step13  Find the word forest and replace it with wood. 

Step14 Save your document. 
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MS Word Exercise 4.7 

 

1. Create a New Word document and Rename as <your student number-exe4.7> 

2. Type the following on page1: 

Service Level Agreement (SLA) For WSU’s Virtual Lab 

By – Sharon Dover 

3. Copy paste the following text on page3:  

General Overview 

This is a Service Level Agreement (“SLA”) between the campus community and the Information 

Technology 

Services Division (ITS) to document: 

▪ The technology services ITS provides to the campus. 
▪ The responsibilities of ITS as a provider of these services and clients receiving services. 
▪ Processes for requesting services. 

This SLA shall remain valid until revised or terminated. 

Service Description 

Service Scope 

Provide Creative Suite software to Students thru Weber’s Virtual Lab. 

Assumptions 

▪ Services provided by ITS are clearly documented in the ITS service catalog. 
▪ Major upgrades will be treated as projects outside the scope of this Agreement. 
▪ Funding for major updates will be negotiated on a service-by-service basis. 
▪ Changes to services will be communicated and documented to all stakeholders via email. 

 
Roles and Responsibilities 

Parties 

The following Service Owner(s) will be used as the basis of the Agreement and represent the 

primary 

Stakeholders associated with this SLA: 

Add Table:  

Stakeholder Title / Role * Contact Information 

Service Owner 1 [Title / Role] [Contact Information] 

     

Computing Support’s Responsibilities  

Computing Support’s responsibilities and/or requirements in support of this Agreement include: 

▪ Meet response times associated with the priority assigned to incidents and service 
requests. 
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▪ Generating quarterly reports on service level performance. 
▪ Appropriate notification to Customer for all scheduled maintenance via the Maintenance 

Calendar, service. 
Customer Responsibilities 

Customer responsibilities and/or requirements in support of this Agreement include: 

▪ Availability of customer representative(s) when resolving a service-related incident or 
request. 

▪ Communicate specific service availability requirements. 
 

4. Apply a theme named Slice to the Word document. 

5. Make the following formatting to the text on page1:  

(a) Font Size: 26 

(b) Alignment: left 

(c) Font Color: Dark Blue  

6. Make the following formatting to the text on page3:  

Select the appropriate text and make the following changes using shortcut keys:  

(a) Bold the words “General Overview, Service Description, Roles and Responsibilities”. 

(b) Bold and Italicize “Service Scope, Assumptions, Parties, Computing Supports 
Responsibilities and Customer Responsibilities”. 

(c) Underline the words “General Overview, Service Description, Roles and Responsibilities”. 

(d) Decrease the font size of the “Customers Responsibilities” by 2 points. 

(e) Increase the font size of the sentence “This is a Service Level Agreement” to 6 points. 

(f) Center align the word “General Overview”. 

(g) Right align your “Service Description”. 

(h) Copy the text below “Customers Responsibilities” and paste it two times in page4. 

(i) Cut the sentence “Communicate specific service availability requirements” and paste the 

text on page4. 

7. Select “General Overview” and convert the Text as Heading 1.  

8. Select “Service Description” and convert the Text as Heading 1.  

9. Select “Roles and Responsibilities” and convert the Text as Heading 1.  

10. Select “Service Scope” and convert the Text as Heading 2.  
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11. Select “Assumptions” and convert the Text as Heading 2.  

12. Select “Parties” and convert the Text as Heading 2.  

13. Select “Computing Supports Responsibilities” and convert the Text as Heading 2.  

14. Select “Customer Responsibilities” and convert the Text as Heading 2.  

15. Insert Automatic Table of Content on page2 of your document.  

16. Save the document. 

 

COMMON SHORTCUT KEYS THAT CAN BE USED IN MICROSOFT WORD: 

To bold text CTRL+B  To right align text CTRL+R 

To italicize text CTRL+I  To left align text CTRL+L 

To underline text CTRL+U  To center align text CTRL+E 

To decrease font size CTRL+[  To select text SHIFT+ARROW KEYS 

To increase font size CTRL+]  To save a file CTRL+S 

To copy selected text CTRL+C  To save as a file F12 

To cut selected text CTRL+X  To close a document ALT+F4 

To paste selected text CTRL+V  To select all text CTRL+A 

To print CTRL+P  
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MS Word Exercise 4.8 

1. Using your knowledge in MS word create the following document. 

2. Page1: 

 

 

 

 

 

 

 

 

 

 

 

  

 

3. Page 2:  

 

 

 

 

 

 

4. On Page3 create a Birthday greeting card for your friend. 

5. Save the document with the file name <your student number-exe4.8> 

  

Day Hours at 

Location 

Items Sold Total Receipts 

Monday 4 62 $374.28 

Tuesday 3 28 $115.19 

Wednesday 2 32 $202.87 

Thursday 2 21 $85.85 

Friday 5 115 $624.39 

Saturday 5 228 $1,401.03 

Winning team gets $25 in gift cards to Luigi’s!   

Trivia Night
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MS Word Exercise 4.9 

Download the Microsoft Word file From Moodle  

Answer the given multiple-choice questions using the downloaded MS Word file 

1. What is the type of Font used in the document for the text in the shape given below? 

 

 

A. Times New Roman 

B. Bradley Hand ITC 

C. Arial 

2. Page Number in this document is inserted at the …….. 

A. Top of the page 

B. Bottom of the page 

C. Center if the page 

3. In the shape given below, the measurement of the size of the shape is: 

 

A. Height x Width (3.69” x 7.02”) 

B. Height x Width (3.59” x 0.32”) 

C. Height x Width (0.98” x 3.02”) 

4. In the given document, the Line spacing option for the text is: 

A. 1.0 

B. 1.5 

C. 1.15 

5. In the given document, which feature in MS Word is used to join objects together and move them 

as single object? 

A. Merge 

B. Group 

C. Wrap  
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MS Excel Exercises 

MS Excel Exercise 5.1 

1. Create a New folder on the desktop and Rename it as “MS Excel Exercise”. 

2. Create a New Microsoft Excel worksheet and Rename as <your student number-5.1> 

3. Type the following Excel Table: 

Student Attendance Details 

Student ID First Name Date of Joining Attendance 

1506023 Mohammed 11/11/2015 100 

1405002 Saif 2/3/2014 95.6 

1601777 Khalid 7/12/2016 88.4 
 

4. Add Sheet 2 and Sheet 3. 

5. Rename Sheet 1 as SORTING.  

6. Move the Sheet SORTING before Sheet 3.  

7. Delete the Sheets, Sheet2 and Sheet3.  

8. Copy the Sheet SORTING at the end and Rename the new sheet as ‘NAME’.  

9. Sort the column First Name in alphabetical order in the Sheet NAME.  

10. Delete the Date of Joining column in Sheet NAME. 

11. Copy the Sheet SORTING at the end and Rename the new sheet as NUMBER.  

12. Sort the column attendance in Sheet NUMBER from Smallest to Largest.  

13. Delete the Row with student ID 1506023 in Sheet Number. 

14. Copy the Sheet SORTING at the end and Rename the new sheet as DATE.  

15. Sort the column Date of Joining from Oldest to Newest in the Sheet DATE.  

16. Set a different Tab Color for each sheet.  

17. Select a cell style of your choice for the Sheet SORTING.  

18. Hide the column ‘Attendance’.  

19. Freeze the second row of the table.  

20. Save the file. 
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MS Excel Exercise 5.2 

1. Create a New Microsoft Excel worksheet and Rename as <your student number-5.2> 

2. Create the following Excel table: 

CALCULATIONS 

Data1 Data2 Avg Add(+) Max Min Sub(-) Div(/) Mul(*) Perc(%) Example Date &Time 

0.6 2           

0.05 0.4           

0.07 0.3           

 

3. Rename the Sheet as Excel 1.  

4. Change the Row height size: 40 for the first row in the table.  

5. Align the text in row1 as Horizontal: Middle and Vertical: Top.  

6. Calculate the Average and Add (sum) for Data1 and Data2 using ∑ method.  

7. Calculate the Maximum and Minimum for Data1 and Data2 rows using functions.  

8. Subtract Data2 from Data1 for all the rows by using the formula Data1 - Data2. 

9. Divide Max by Min for all the rows by using the formula Max/Min. 

10. Calculate Data1*0.5 for all the rows.  

11. Copy the cells from H3 to H5 and paste it into J3 to J5.  

12. Format the numbers in the column J with percentage (%) symbol and make no decimal places. 

13. Calculate the Example for all the data using the formula (Data1×2) - (Data2×0.3).  

14. Insert the current date & current time in the Date &Time column. (Use the function ‘=Now()’) 

15. Copy cells B3 to B5 and paste Link into Sheet 2..  

16. Print the sheet Excel1.  

17. Save the file. 
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MS Excel Exercise 5.3  

1. Create a New Microsoft Excel file and Rename as <your student number-exe5.3> 

2. Type the following Excel table in Sheet1: 

Military Technological College 

Student Progress Statement 

SI No. 
Student 

Number 
Student name Quiz1 Quiz2 Midterm End term Exam Final marks 

1 140567 Saif 25 59 65 79  

2 140231 Laith 72 45 78 80  

3 140006 Khaleel 46 45 39 35  

4 140467 Muad 67 57 45 50  

5 140890 Ahmed 78 80 75 90  

 

3. Rename Sheet1 as ‘MTC’.  

4. Calculate the Final marks, use the following formula. 

Final Marks = Quiz1 × 0.1 + Quiz2 × 0.1 + Midterm × 0.3 + End term Marks × 0.5 

5. Insert a Clustered Column chart for the above table.  

a. Move Chart to a new sheet and Rename the sheet as ‘Clustered Chart’.  

b. Insert a Chart Title to the Clustered chart as ‘Student Progress Statement’.  

c. Format the Chart Title with any WordArt.  

d. Label Horizontal Axis Title as ‘Student’.  

e. Label Vertical Axis Title as ‘Marks’.  

f. Format the legend of the Clustered Chart to the Left side.  

g. Show the data labels for the above Clustered Chart.  

6. Insert a 3-D pie chart for the column End term exam.  

a. Move the chart to a new sheet and Rename the Sheet as ‘Pie Chart’.  

b. Fill Green color to the Chart area and yellow color to the Plot area of the Pie chart.  

c. Format the data series for the Pie chart as Angle of First slice: 50 and Point of 

Explosion: 40%.  

d. Show the data labels for the Pie chart at outside end.  

e. Select a different Chart style for the Pie chart.  

7. Insert a Scatter chart for the columns Student name, Quiz1 and Quiz2.  

a. Format the Quick Layout of the Scatter chart to Layout 5.  

8. Save the file.  
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MS Excel Exercise 5.4 

1. Create a New Microsoft Excel worksheet and Rename as <your student number-5.4> 

Day Breakfast Lunch Dinner L – Spark  C – Spark 

Saturday 40 25 33   

Sunday 26 10 43   

Monday 12 46 58   

Tuesday 25 50 16   

Wednesday 45 54 17   

2. Rename the Sheet as ‘First’.  

3. Create a copy of the Sheet ‘First’ and Rename it as ‘Second’ 

4. Do the following in Sheet ‘Second’  

(a) Insert Line Sparkline for the data in the above table, Location ‘L – Spark’ column. 

(b) Change the line color of the Sparkline make it Purple color.  

(c) Highlight the Highest points in the Sparkline with Red color.  

(d) Insert Column Sparkline for the data in the above table, Location ‘C – Spark’ column.  

(e) Highlight the Highest points in the Column Sparkline with Green color and the Lowest 

points with Yellow color.  

5. Create a copy of the Sheet ‘First’ and Rename it as ‘Third’.  

6. Do the following in the Sheet ‘Third’. 

(a) Highlight (Fill Color) the cells that are greater than 40 with Red color using Conditional 

Formatting.  

(b) Highlight (Fill Color) the cells that are lesser than 20 with Green color using Conditional 

Formatting. 

(See the other features in Highlight [Border color, Font color also can be changed]) 

7. Copy Sheet First into a new Sheet and Rename the new Sheet as ‘Condition 1’.  

(a) Using Conditional Formatting, Highlight the Top 3 data with Blue color and the Bottom 3 

data with Yellow color in ‘Condition 1’ Sheet. 

8. Copy Sheet First into a new Sheet and Rename the new Sheet as ‘Condition 2’. 

9. Visualize the data in Sheet ‘Condition 2’ with icon sets using Conditional Formatting option. 

Use the following rules. 

(a) Visualize the data into three groups: Data >50 ,30 ≤ Data ≤ 50, and Data <30 

10. Save the file.   
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MS Excel Exercise 5.5 

 

   The Table includes measured data on the current-voltage relationship of a diode. 

I [mA] V [Volts] 

0 0 

0.001 0.24 

0.005 0.34 

0.01 0.36 

0.02 0.39 

0.05 0.43 

0.1 0.46 

0.2 0.49 

0.5 0.53 

1.0 0.57 

2.0 0.60 

 

1) Create a new Microsoft Excel file and Rename as “Electrical Lab”. 

2) Type the above Excel table on sheet1. 

3) Rename the Sheet1 as ‘Diode I – V’. 

4) Insert a Scatter with straight line chart to show the relationship between the amount of current 

and voltage.  

5) Format the Chart Title as “Diode I - V”  

6) Label Axis Titles (x-axis and y-axis) as the table headers. 

7) Include data labels on the chart 

8) Include the legend under (bottom) the chart. 

9) Change the chart style into style 6. 

10) Save the file. 
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MS Excel Exercise 5.6 

 

Step1 Create an Excel file on the Desktop. 

Step2 Rename the file as your “Student ID Number”.   

Step3 Type the Excel table below on sheet1:          

 Internet of things units installed in each year (in millions) 

Category 2013 2014 2015 2020 

Automotive 96 189 372 3511 

Consumer 1842 2244 2874 13172 

Generic Business 395 479 623 5158 

Vertical Business 698 836 1009 3164 

Total     

Step4 Rename Sheet1 as ‘IoT’  

Step5 Calculate the Total for each column. (Use SUM function)   

Step6 Select the columns, "Category", "2013", "2014", "2015", and "2020" and insert a Bar chart as 

shown below.  

 

 

 

 

 

 

Step7 Make the following changes on the chart.  

1) Change the Chart Title as “Internet of Things Units Installed”.  

2) Label Horizontal Axis as “Number of IoT Units”.   

3) Label Vertical Axis as “Category”.    

4) Include the legend on right-hand side of the chart.   

Step8 Move chart into a New sheet. 

Step9     Save the file 

  

0 2000 4000 6000 8000 10000 12000 14000

Automotive

Consumer

Generic Business

Vertical Business

Chart Title

2020 2015 2014 2013
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MS Excel Exercise 5.7 

 

1. Create a new Microsoft Excel file and Rename as <your student number-5.7> 

2. Type the following Excel table on sheet1: 

3. Change the Row height size: 40 for the first row in the table.  

4. Align the text in row1 as Horizontal: left and vertical: Top.  

5. Fill yellow color to the column ‘Sale Jan’. 

6. Select a different border for the column Sale Jan.  

7. Calculate Average using AutoSum.  

8. Calculate Difference using the formula: Difference = Sale Jan – Sale Feb.  

9. Calculate Income using the formula: Income = (Sale Jan + Sale Feb) * 450 

10. Insert a Scatter Chart for the column ‘Sale Jan’. 

a. Change the Chart layout of the scatter chart to layout 6.  

11. Copy Sheet 1 into a new sheet and Rename the new sheet as ‘Condition 1’.  

12. In the Condition1 sheet, highlight the cells in Income column that are Greater than 50000 with 

Green color using Conditional Formatting features.  

13. Visualize the data in sheet1(Sale Jan & Sale Feb) with icon sets using Conditional Formatting 

option. Use following rules 

IF Data>100 red circles, IF Data >=60 and <=100 no Icon, Data < 60 yellow circles 

14. Copy sheet 1 into a new sheet and Rename the new sheet as ‘Column Sparkline’.  

15. Insert Column Sparkline for each row in the Sparkline column.  

a. Highlight the Highest points in the Column Sparkline with Red color and Lowest 

points with Yellow Color.  

Software Sale Jan Sale Feb Average Difference Income 
Date & 

Time 

Column 

Sparkline 

Inventory 200 100      

Word Editor 90 80      

Presentation tool 40 60      

Media Player 70 50      

Search Engine 250 200      

Router Manager 80 90      

Browser 60 70      



Page | 24  
FPD-COMPUTING [MTCG1015] 
 

16. Insert Current Date & Time in Date & Time column.  

17. Insert a Clustered Column Chart to include the sales of software in January and February for 

the above table.  

18. Move the Chart to a new sheet and Rename the sheet as ‘Column Chart’.  

19. Change the Legend of the Column Chart to the top side.  

20. Label the Horizontal Axis Title as ‘month’.  

21. Label the Vertical Axis Title as ‘Sale’.  

22. Show Data Label for the above Column chart in inside End.  

23. Create a 3-D Pie Chart for the column Sale Jan.  

24. Move the chart to a new sheet and Rename the sheet as Pie Chart.  

25. Format data series for the Pie Chart as Angle of first slice: 40 and Point of explosion: 35%. 

26. Save the file. 

 

MS Excel Exercise 5.8 

 

In a city, the following weekly observations were made in a study on the cost-of-living index. 

Cost of living Index Number of weeks 

140 – 150 5 

150 – 160 10 

160 - 170 20 

170 – 180 9 

180 – 190 6 

190 - 200 2 

 

1. Create a new Microsoft Excel file and Rename as <your student number-exe5.8> 

2. Copy the Column Number of weeks and paste as 3rd column of the table 

3. Create Histogram, Line Graph and Combo Chart for the Data. 

4. Save the file. 
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MS Excel Exercise 5.9 

 

The electricity bills of 25 houses are given below: 

150, 212, 252, 310, 712, 412, 425, 322, 325, 192, 198, 230, 320, 412, 530, 602, 724, 370, 402, 317, 403, 

405, 372, 413, 290. 

1. Create a new Microsoft Excel file and Rename as <your student number-exe5.9> 

2. Rename Sheet1 as ‘Histogram’ 

3. Type the above data in one column on sheet Histogram 

4. Type the table given below on Sheet Histogram 

Class Interval Upper Bin Frequency 

75-149 149    

150-224 224  

225-299 299  

300-374 374  

375-449 449  

450-524 524  

525-599 599  

600-674 674  

675-749 749  

5. Calculate Frequency (use frequency function or can be done manually) 

6. Construct a Histogram using the Columns Class Interval and Frequency 

7. Copy the columns Class Interval, and Frequency to sheet 2. 

8. On sheet 2, construct a Line graph using columns Class Interval and Frequency. 

9. Copy and paste the columns of Class Interval and Frequency on Sheet 3 

10. Copy the Column frequency and paste as 4th column of the table 

11. Insert a Histogram and Line Graph, Combo Chart for the Data 

12. Rename Sheet 3 as ‘Combo Chart’. 

13. Save the file. 
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MS Excel Exercise 5.10  
Download the Microsoft Excel file from Moodle 

Answer the given multiple-choice questions using the downloaded MS Excel file  

1. In Sheet 1, what is the Number format of the cells from G4 to G7? 

A. General 

B. Text 

C. Date 

2. Which formula is used to find the Total orders by Date? 

A. =SUM(H4:H7) 

B. SUM(H4:H7) 

C. =TOTAL(H4:H7) 

3. How can you apply a filter to a range of data in Excel? 

A. Go to Data > Sort 

B. Select the range and press Ctrl+F 

C. Go to Data > Filter 

4. How can you insert a new column in Excel? 

A. Right-click on the column header and select "Delete" 

B. Go to Insert > Column 

C. Press Ctrl+S 

5. In the given Excel sheet, which of the following feature is used to quickly convert range of cells in 

Table with its own style? 

A. Conditional Formatting 

B. Cell Style 

C. Format as Table 
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MS PowerPoint Exercises 

MS PPT Exercise 6.1 

1. Create a folder on the desktop and name it as “MS PPT Exercises”. 

2. Create a new Microsoft PowerPoint Presentation and Rename as <your student number-6.1> 

3. Open the PowerPoint file and make the presentation with the following details: 

Slide 1:  Slide Layout: Title Only 

Title: MATTER 

Slide 2:  Slide Layout: Title and Content 

Title: Atom 

Text: The smallest indivisible particle. 

It has properties of an element. 

Slide 3:  Slide Layout: Comparison 

Title: Particles of an atom 

Text: Proton Electron 

Text: +ve charged particles -ve charged particles 

 

Slide 4:  Slide Layout: Title and Content 

Title: Valence Shell 

Text: The outermost shell of the atom.  

Slide 5:  Slide Layout: Content with Caption 

Title: States of matter 

Text: Four states of matter are observable in everyday life: solid, liquid, gas, and 

plasma. 
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Slide 6: Slide layout: Blank 

Text: 

 Helium 

Neon 

Argon 

Hydrogen 

Oxygen 

Carbon  
4. Do the following formatting to the title in slide 1: 

(a) Font: Broadway,  

(b) Font size: 60  

(c) Alignment: Center   

(d) Font style:  Italic, Underline 
 

5. Format the title in slide 2 as font color: blue.  

6. Apply Numbering to the text in slide 2.  

7. Using change case command, format the title in slide 3 as UPPERCASE.  

8. Do the following formatting to the title in slide 4:  

(a) Font: Cambria 

(b) Font size: 28  

(c) Font Style: Underline 
 

9. Add a shadow on the title in slide 5.  

10. Apply bullets to the text in slide 6.  

11. Insert the slides in the presentation as follows:  

Slide 7:   Slide layout: Picture with Caption 

   Title: Oxygen atom 

      Font size: 36 

Slide 8:   Slide layout: Two Content 

      Title:  What is an ion? 

Slide 9:   Slide layout: Blank 

Slide 10: Slide Layout: Blank 

12. Insert a picture of an Oxygen atom using Google (or online pictures) in slide 7.  

13. Apply a picture style of your choice to the picture in slide 7.  
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14. Insert a picture of a Sodium ion using Google (or online pictures) in slide 8. 

15. Change the color of the picture (Sodium ion) as:  

(a) Color Saturation: 200% 

(b) Color Tone: 5900 K  

16. Insert the following SmartArt in slide8: 

 

17. Name of the SmartArt is ____________________. 

18. Insert a Word Art with text ‘Different Shapes’ in slide 9.  

19. Insert 3 different shapes in slide 9.  

20. Insert the following table in slide 10:  

 

 

 

 

21. Insert a pie chart for the above table in slide 10.  

  

Cation

Na+

H+

Anions

Cl-

O2-

Element Valence 

Oxygen 6 

Phosphorus 5 

Chlorine 1 

Cobalt 2 

Zinc 2 

Boron 3 
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22. Copy slide 6 and paste at the end of the presentation.  

23. Convert the text in slide 11 to the ‘Pyramid List’ SmartArt.  

24. Copy slide 5 and paste at the end of the presentation.  

25. Change the Layout of slide 12 to ‘Two Content’. 

26. Insert the following SmartArt in slide 12:  

 
27. Name of the SmartArt is _______________. 

 

28. Apply a WordArt style to the title in slide 12.  

29. Insert the following shape in slide 6:  

 

 
 
 

 

30. Apply a design theme of ‘Wisp’ to all the slides in the presentation.  

31. Do the following to the respective slides:  

Slide1:  
Theme: Slice  
Transition: Curtains  
On the Title apply Animation Entrance – Bounce  

 

Slide2:  
Transition: Cube 

Set transition timing after 5 seconds 

  

States 
of 

matter

Solid

Liquid

Gas

Inert Gases 
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Slide3:  
Theme: Facet  
Transition: Ripple  
Effect Options: From Bottom-Right  
Set transition timing after 3 seconds 

On the Title apply Animation Emphasis – Spin 
  

Slide5:  
Theme: Ion  
Transition: Crush  

Set transition timing after 5 seconds  
On the Title apply Animation Brush Color  

Slide6: 
 

Format the Background with Pattern fill 

Transition: Wind; Effect Options:  Left  
Set transition timing after 5 seconds 

On the Shape apply Entrance Animation – Zoom; Effect Options: Slide Center 

Set animation duration 3 seconds  
Slide7:  

Theme: Ion  
Transition: Fracture 

Set transition timing after 5 seconds 

 
  

Slide8:  
Theme: Organic  
Transition: Blinds; Effect Options: Horizontal 

Set transition timing after 5 seconds 

 
 

Slide10:  
Theme: Retrospect  
Transition: Airplane 

Set transition timing after 5 seconds 

 
  

Slide11:  
Format the Background with Solid fill 

Theme: Facet  
Transition: Page Curl 

Set transition timing after 5 seconds 
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Slide12:  
On the SmartArt apply Animation Grow & Turn 

Set animation duration 3 seconds  
Transition: Origami  
Effect Options: Left 

 
32. In slide 7, insert a shape to cover the entire picture (Oxygen atom). 

a. Move the shape behind the picture (Send Backward). 

33. In slide 9, select all three shapes and group them together. 

34. Create an action button (Home) in the last slide that returns to the first slide in the presentation.  

35. Create an action button (Next) in the slide 4 that goes to the slide 5 in the presentation.  

36. Create an action button (End) in slide1 that returns to the last slide in the presentation.  

37. Check the action buttons by viewing the presentation in Slide Show view.  

38. Save the presentation. 
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MS PPT Exercise 6.2 

 

1. Create a new Microsoft PowerPoint Presentation and Rename as <your student number-6.2> 

2. View the Slide Master. 

3. Insert a shape (Oval) on the Slide Master. 

4. Go to Title and Content Slide Layout and insert a shape (Rectangle). 

5. Close Master View. 

 

6. Slide 1:  

Insert a new Title Slide that contains the Oval shape. 

7. Slide 2: 

Insert a new Title and Content slide that contains two shapes. 

8. Slide 3: 

Insert a new Two Content slide that contains the Oval shape. 

 

9. Explain the advantage of using Slide Master in PowerPoint Presentations. 

10. Handout Master: 

      View Handout Master.  

       Insert your student ID number on the Header.   

       Close Master View. 

 

11. Notes Master: 

      View Notes Master.  
 

      Type your name on the Footer   

      Close Master View. 

 

12. Insert date & time, slide numbers and student ID number on the footer on all the slides. 

13. Save the file. 
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MS PPT Exercise 6.3 

 

Step1 Create a PowerPoint file on the desktop. 

Step2 Rename the file as your “Student ID Number”.   

Step3 Open the PowerPoint file and create slides with the following details: 

Slide1: 

Slide layout: Section Header  

            Title: Computer Software  

            Text: Consists of computer instructions.  

            Insert Comment (To the title): “Computer programs.”    

 

Slide2: 

        Slide layout: Title and Content     

Add Title: Different Types of Software  

Insert the SmartArt shown below:      

                        

  

System 
Software 

(OS)

Programming 
Software

Application 
Software

Embedded 
Software
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Master Slide: 

        View Slide Master: Title Only Layout  

Insert the shape shown below.  

 

 

 

 

Close Master View  

 

Handout Master: 

       View Handout Master: 

Insert your student ID number on the Header   

Close Master View 

 

Notes Master: 

       View Notes Master:  

Type your name on the Footer   

Close Master View 

Slide3: 

        Slide layout: Title Only Layout 

 

Step4 Save your file. 

  

Computer cannot run 
without software 
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MS PPT Exercise 6.4 

1. Create a Photo album by inserting four pictures from your computer. (If you don’t have any picture 

on your computer insert four online pictures of your choice).  

2. Select the option to insert two pictures in a slide. 

3. Insert slide numbers for all the slides. 

4. Insert date and time for all the slides.  

5. Insert footer and type ‘Student ID Number’ and ‘Name’.  

6. Copy Slide 2 and paste it below Slide 3. 

7. Give a theme of your choice to the presentation.  

8. Apply Transition Reveal to slide 1 and Transition Curtain to slide 2. 

9. Type ‘Beginning of the presentation’ as Notes in Slide 1. 

10. Add a new section on slide 3. 

11. Rename the Default section as ‘Album1’ and Untitled section as ‘Album2’.  

12. Mark the PowerPoint as final. 

13. Add password to the file as ‘abc’. 

14. Export (Save) the presentation as a video file. 

15. Save the presentation inside your folder as <your student number-6.4> 
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MS PPT Exercise 6.5 

1. Open PPT folder.  

2. Create a New Microsoft PowerPoint Presentation and Rename as <your student number-6.5> 

3. Open the PowerPoint file and make the presentation with the following details: 

4. Use the suitable slide layouts and type the following text in the respective slides. 

(a) Slide 1: Title: “Sports at MTC” 
 

(b) Slide 2: Title: “Join with your team"   

 Text: “It’s time to join with your favorite team” 
 

(c) Slide 3: Title: Together, We Win! 

 Text: 

a. Football 

b.Hockey 

c. Baseball 

d.Swimming 

e. Basketball 
 

▪ Format the five lines of text to be left aligned. 

▪ Apply the bullets Check Marks. 

▪ Format the fill and border of the Textbox. 

▪ Select the Title on Slide 3. 

a) Change the Text direction of the Title to be Vertical. 

b) Rearrange the Text Boxes for the Title and the bulleted list to fit on the 

slide. 

5. Insert five (5) new slides and type the following as titles 

(a) Football 

(b) Hockey 

(c) Baseball 

(d) Swimming 

(e) Basketball 

6. Type names of team captains in each new slide. (If you don’t know use Google to find names) 

7. Add a picture to slide 4 that matches with the sport (Insert a picture from Clip Art or File).  
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8. Format the Picture using Picture Tools. 

9. Insert an AutoShape to cover the entire picture. 

10. Move the AutoShape behind the picture. 

11. Format the AutoShape's color and line style. 

12. Insert an AutoShape Arrow pointing to the picture.   

13. Format the AutoShape Arrow. 

14. Grouping Objects. 

15. In the Slide 4 Select the arrow and the AutoShape, group these objects together.  

16. Move the grouped objects to see the behavior. 
 

Animation and Transitions 
 

17. Bouncing ball 

(a) Search ClipArt and find a picture or a cartoon of a football. 

(b) Insert the picture on the football slide and resize it to a small size. 

18. Custom Animation 

(a) Select the football picture and go to Animation->Entrance-> Bounce. 

(b) Select the football and Choose Motion Path.  

(c) Draw a Custom Path that makes the football dribble across the slide. 

(d) Insert a picture of a football player in slide 4. 

(e) Add a custom path to which the player will run any ware in the slide. 

19. Change the animation in such a way that the player follows the ball. 

20. Add sound effect to the animation. Ex. Audience is clapping. 

21. Slide Transitions 

(a) Animate each slide with a transition. 

(b) Use one of the transitions in the animation gallery. 

(c) Modify the animation to automatically after 5 seconds. 

(d) Try changing the timing to 10, 15, and 30 seconds. 

22. Slide formatting 

(a) Format the background of each slide to be each a different shade of blue. 

(b) Format the background of the first slide to be a fill effect. 

23. Save and view the slide show in Slide Show. 

  



Page | 39  
FPD-COMPUTING [MTCG1015] 
 

MS PPT Exercise 6.6 

 

Using 5 slides create a PowerPoint presentation about your school. 

Instructions 

1. Slide 1: Title slide layout “ School name” 

2. Slide 2: History 

3. Slide 3: About teachers and students 

4. Slide 4: Student societies  

5. Slide 5: Sports 

(a) Insert pictures, add slide animations and text animations that work for the presentation! 

(b) Add ONE slide with a Picture as BACKGROUND SLIDE. 

(c) Make sure you don’t have too much information on one slide (6 by 6 Rule) 

(d) Insert ONE Smart Art, ONE Shape and ONE Word  Art  

(e) Insert Transitions on Every Slide (can be different) and AT LEAST FIVE ANIMATIONS 

(throughout the presentation!) 

6. Print your presentation on a single A4 page. 

7. Save the file and Rename as <your student number-exe6.6> 
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MS PPT Exercise 6.7 

Download the Microsoft PowerPoint file from Moodle 

Answer the given multiple-choice questions using the downloaded MS PPT file  

1. In the presentation view, you can see the effect of the Random Bars is applied to Slide 1. Which 

Tab is used to apply the curtain effect? 

A. Animations 

B. Transitions 

C. Design 

2. In the given Presentation, what is the Layout of Slide 2?. 

A. Two Content 

B. Title Slide 

C. Title and Content 

3. In Slide 4, which illustration is used to insert the object shown in the image below? 

 

A. SmartArt Graphics 

B. Themes 

C. Icons 

4. Which Tab on the PowerPoint ribbon is used for applying theme to the slides? 

A. Insert 

B. Design 

C. Slide Show 

5. There is an Action Button added in Slide 4. If you click this Button, it will jump to which slide? 

A. Slide 1 

B. Slide 2 

C. Slide 3 
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